Chapter 445

Tests for the Ratio of Two Means (Log-Normal Data)

Introduction

This procedure calculates power and sample size for t-tests from a parallel-groups design in which the logarithm of the outcome is a continuous normal random variable. This routine deals with the case in which the statistical hypotheses are expressed in terms of mean ratios instead of mean differences.

The details of testing two treatments using data from a two-group design are given in another chapter, and they will not be repeated here. If the logarithms of the responses can be assumed to follow a normal distribution, hypotheses stated in terms of the ratio can be transformed into hypotheses about the difference. The details of this analysis are given in Julious (2004). They will only be summarized here.

Testing Using Ratios

It will be convenient to adopt the following specialized notation for the discussion of these tests.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>PASS Input/Output</th>
<th>Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td>( \mu_T )</td>
<td>Not used</td>
<td>Treatment mean. This is the treatment (group 1) mean.</td>
</tr>
<tr>
<td>( \mu_R )</td>
<td>Not used</td>
<td>Reference mean. This is the reference (group 2) mean.</td>
</tr>
<tr>
<td>( \phi_0 )</td>
<td>R0</td>
<td>Null ratio. This is the value of ( \phi = \mu_T / \mu_R ) under the null hypothesis, ( H_0 ).</td>
</tr>
<tr>
<td>( \phi )</td>
<td>R1</td>
<td>Actual ratio. This is the value of ( \phi = \mu_T / \mu_R ) at which the power is calculated.</td>
</tr>
</tbody>
</table>

Note that the actual values of \( \mu_T \) and \( \mu_R \) are not needed. Only the ratio of these values is needed for power and sample size calculations.

In the two-sided case, the null and alternative hypotheses are

\[
H_0: \phi = \phi_0 \quad \text{versus} \quad H_1: \phi \neq \phi_0.
\]

The one-sided hypotheses are

\[
H_0: \phi \leq \phi_0 \quad \text{versus} \quad H_1: \phi > \phi_0
\]

and

\[
H_0: \phi \geq \phi_0 \quad \text{versus} \quad H_1: \phi < \phi_0.
\]
Log-Transformation

In many cases, hypotheses stated in terms of ratios are more convenient than hypotheses stated in terms of differences. This is because ratios can be interpreted as percentages, but differences must be interpreted as actual amounts in their original scale. Hence, it has become a common practice to take the following steps in hypothesis testing.

1. State the statistical hypotheses in terms of the ratio of the means.
2. Transform this into hypotheses about a difference by taking logarithms.
3. Analyze the logged data—that is, do the analysis in terms of the difference.
4. Draw the conclusion in terms of the ratio.

The details of step 2 for the two-sided null hypothesis are as follows:

\[ H_0: \phi = \phi_0 \implies H_0: \frac{\mu_T}{\mu_R} = \phi_0 \implies H_0: \ln(\frac{\mu_T}{\mu_R}) = \ln(\phi_0) \]

Thus, a hypothesis about the ratio of the means on the original scale can be translated into a hypothesis about the difference of two means on the logged scale.

Coefficient of Variation

The coefficient of variation (COV) is the ratio of the standard deviation to the mean. This parameter can be used to represent the variation in the data because of a unique relationship that it has in the case of log-normal data.

Suppose the variable \( X \) is the logarithm of the original variable \( Y \). That is, \( X = \ln(Y) \) and \( Y = \exp(X) \). Label the mean and variance of \( X \) as \( \mu_X \) and \( \sigma_X^2 \), respectively. Similarly, label the mean and variance of \( Y \) as \( \mu_Y \) and \( \sigma_Y^2 \), respectively. If \( X \) is normally distributed, then \( Y \) is log-normally distributed. Julious (2004) presents the following well-known relationships between these two variables:

\[
\begin{align*}
\mu_Y &= e^{\mu_X + \frac{\sigma_X^2}{2}} \\
\sigma_Y^2 &= \mu_Y^2 (e^{\sigma_X^2} - 1)
\end{align*}
\]

From this relationship, the coefficient of variation of \( Y \) can be found to be

\[
COV_Y = \frac{\sqrt{\mu_Y^2 (e^{\sigma_X^2} - 1)}}{\mu_Y} = \sqrt{e^{\sigma_X^2} - 1}
\]

Solving this relationship for \( \sigma_X^2 \), the standard deviation of \( X \) can be stated in terms of the coefficient of variation of \( Y \) as

\[
\sigma_X = \sqrt{\ln(COV_Y^2 + 1)}
\]

Similarly, the mean of \( X \) is

\[
\mu_X = \ln\left(\frac{\mu_Y}{\sqrt{COV_Y^2 + 1}}\right)
\]

Thus, the hypotheses can be stated in the original (\( Y \)) scale and then the power can be analyzed in the transformed (\( X \)) scale. For parallel-group designs, \( \sigma_X^2 = \sigma_d^2 \), the average variance used in the t-test of the logged data.
Power Calculation

As is shown above, the hypotheses can be stated in the original (Y) scale using ratios or the logged (X) scale using differences. In either case, the power and sample size calculations are made using the formulas for testing the difference in two means. These formulas are presented in another chapter and are not duplicated here.

Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab

The Design tab contains the parameters associated with this test such as the ratios, sample sizes, alpha, and power.

Solve For

Solve For

This option specifies the parameter to be solved for from the other parameters. In most situations, you will select either Power or Sample Size (N1).

Test

Alternative Hypothesis

This option specifies the alternative hypothesis. This implicitly specifies the direction of the hypothesis test. Possible selections are:

- **Two-Sided (H1: R ≠ R0)**
  This is the most common selection. It yields the two-tailed t-test.

- **One-Sided (H1: R < R0)**
  This option yields a one-tailed t-test.

- **One-Sided (H1: R > R0)**
  This option yields a one-tailed t-test.

Power and Alpha

Power

This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of equal means when in fact the means are different.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Tests for the Ratio of Two Means (Log-Normal Data)

Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of equal means when in fact the means are equal.

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size (When Solving for Sample Size)

Group Allocation
Select the option that describes the constraints on \( N1 \) or \( N2 \) or both.

The options are

- **Equal \((N1 = N2)\)**
  This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both sample sizes at once, no additional sample size parameters need to be entered.

- **Enter \( N2 \), solve for \( N1 \)**
  Select this option when you wish to fix \( N2 \) at some value (or values), and then solve only for \( N1 \). Please note that for some values of \( N2 \), there may not be a value of \( N1 \) that is large enough to obtain the desired power.

- **Enter \( R = N2/N1 \), solve for \( N1 \) and \( N2 \)**
  For this choice, you set a value for the ratio of \( N2 \) to \( N1 \), and then PASS determines the needed \( N1 \) and \( N2 \), with this ratio, to obtain the desired power. An equivalent representation of the ratio, \( R \), is
  \[ N2 = R \times N1. \]

- **Enter percentage in Group 1, solve for \( N1 \) and \( N2 \)**
  For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS determines the needed \( N1 \) and \( N2 \) with this percentage to obtain the desired power.

\( N2 \) (Sample Size, Group 2)

*This option is displayed if Group Allocation = “Enter \( N2 \), solve for \( N1 \)”*

\( N2 \) is the number of items or individuals sampled from the Group 2 population.

\( N2 \) must be \( \geq 2 \). You can enter a single value or a series of values.

\( R \) (Group Sample Size Ratio)

*This option is displayed only if Group Allocation = “Enter \( R = N2/N1 \), solve for \( N1 \) and \( N2 \).”*

\( R \) is the ratio of \( N2 \) to \( N1 \). That is,

\[ R = \frac{N2}{N1}. \]

Use this value to fix the ratio of \( N2 \) to \( N1 \) while solving for \( N1 \) and \( N2 \). Only sample size combinations with this ratio are considered.

\( N2 \) is related to \( N1 \) by the formula:

\[ N2 = \lceil R \times N1 \rceil, \]

where the value \( \lceil Y \rceil \) is the next integer \( \geq Y \).
For example, setting \( R = 2.0 \) results in a Group 2 sample size that is double the sample size in Group 1 (e.g., \( N_1 = 10 \) and \( N_2 = 20 \), or \( N_1 = 50 \) and \( N_2 = 100 \)).

\( R \) must be greater than 0. If \( R < 1 \), then \( N_2 \) will be less than \( N_1 \); if \( R > 1 \), then \( N_2 \) will be greater than \( N_1 \). You can enter a single or a series of values.

**Percent in Group 1**

*This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for \( N_1 \) and \( N_2 \).”*

Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for \( N_1 \) and \( N_2 \). Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

---

**Sample Size (When Not Solving for Sample Size)**

**Group Allocation**

Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.

The options are:

- **Equal (\( N_1 = N_2 \))**
  This selection is used when you wish to have equal sample sizes in each group. A single per group sample size will be entered.

- **Enter \( N_1 \) and \( N_2 \) individually**
  This choice permits you to enter different values for \( N_1 \) and \( N_2 \).

- **Enter \( N_1 \) and \( R \), where \( N_2 = R \times N_1 \)**
  Choose this option to specify a value (or values) for \( N_1 \), and obtain \( N_2 \) as a ratio (multiple) of \( N_1 \).

- **Enter total sample size and percentage in Group 1**
  Choose this option to specify a value (or values) for the total sample size (\( N \)), obtain \( N_1 \) as a percentage of \( N \), and then \( N_2 \) as \( N - N_1 \).

**Sample Size Per Group**

*This option is displayed only if Group Allocation = “Equal (\( N_1 = N_2 \)).”*

The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2 populations. Since the sample sizes are the same in each group, this value is the value for \( N_1 \), and also the value for \( N_2 \).

The Sample Size Per Group must be \( \geq 2 \). You can enter a single value or a series of values.

**\( N_1 \) (Sample Size, Group 1)**

*This option is displayed if Group Allocation = “Enter \( N_1 \) and \( N_2 \) individually” or “Enter \( N_1 \) and \( R \), where \( N_2 = R \times N_1 \).”*

\( N_1 \) is the number of items or individuals sampled from the Group 1 population.

\( N_1 \) must be \( \geq 2 \). You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.

R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,
\[ R = \frac{N2}{N1} \]
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:
\[ N2 = \lceil R \times N1 \rceil, \]
where the value \[\lceil Y \rceil\] is the next integer ≥ Y.
For example, setting \(R = 2.0\) results in a Group 2 sample size that is double the sample size in Group 1.
\(R\) must be greater than 0. If \(R < 1\), then \(N2\) will be less than \(N1\); if \(R > 1\), then \(N2\) will be greater than \(N1\). You can enter a single value or a series of values.

Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of the total sample size in Group 1, implicitly defines \(N1\) and \(N2\).
The total sample size must be greater than one, but practically, must be greater than 3, since each group sample size needs to be at least 2.
You can enter a single value or a series of values.

Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of values.

Effect Size – Ratios

R0 (Ratio | H0)
This is the value of the ratio of the two means assumed by the null hypothesis, H0. Usually, \(R0 = 1.0\) which implies that the two means are equal. However, you may test other values of \(R0\) as well. Strictly speaking, any positive number is valid, but values near to, or equal to, 1.0 are usually used.
Warning: you cannot use the same value for both \(R0\) and \(R1\).
Tests for the Ratio of Two Means (Log-Normal Data)

**R1 (Actual Ratio)**
This is the value of the ratio of the two means at which the power is to be calculated. Often, a range of values will be tried. For example, you might try the four values:

1.05 1.10 1.15 1.20

Strictly speaking, any positive number is valid. However, numbers between 0.50 and 2.00 are usually used.

Warning: you cannot use the same value for both R0 and R1.

**Effect Size – Coefficient of Variation**

**COV (Coefficient of Variation)**
The coefficient of variation is the ratio of the standard deviation and the mean (SD/Mean). It is used to specify the variability (standard deviation). Note that this COV is defined on the original (not logarithmic) scale. This value must be determined from past experience or from a pilot study.

To be clear, consider the following definition. Suppose data on a response variable Y are collected. This procedure assumes that the values of X = Ln(Y) are analyzed using a two-sample t-test. Thus, there are two sets of means and standard deviations: those of X labelled MX and SX and those of Y labelled MY and SY. The COV entered here is the COV of Y = SY/MY. For log-normal data, the following relationship exists: COV(Y) = SQR(Exp(SX*SX)-1) where SX is the standard deviation of the log-transformed values.
Example 1 – Finding Power

A company has developed a generic drug for treating rheumatism and wants to show that it is better than the standard drug. From previous studies, responses for either treatment are known to follow a lognormal distribution. A parallel-group design will be used and the logged data will be analyzed with a one-sided, two-sample t-test.

Past experience leads the researchers to set the COV to 1.20. The significance level is 0.025. The power will be computed for R1 equal 1.10 and 1.20. Sample sizes between 100 and 900 will be examined in the analysis.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the procedure window. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td>Power</td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>One-Sided (H1: R &gt; R0)</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.025</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>Sample Size Per Group</td>
<td>100 to 900 by 200</td>
</tr>
<tr>
<td>R0 (Ratio</td>
<td>H0)</td>
</tr>
<tr>
<td>R1 (Actual Ratio)</td>
<td>1.1 1.2</td>
</tr>
<tr>
<td>COV (Coefficient of Variation)</td>
<td>1.2</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Numeric Results for a T-Test</th>
</tr>
</thead>
<tbody>
<tr>
<td>R = Treatment Mean / Reference Mean</td>
</tr>
<tr>
<td>Hypotheses: H0: R1 ≤ R0  vs.  H1: R1 &gt; R0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Power</th>
<th>N1</th>
<th>N2</th>
<th>N</th>
<th>R0</th>
<th>R1</th>
<th>COV</th>
<th>Effect Size</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.10568</td>
<td>100</td>
<td>100</td>
<td>200</td>
<td>1.000</td>
<td>1.100</td>
<td>1.200</td>
<td>0.101</td>
<td>0.025</td>
</tr>
<tr>
<td>0.23392</td>
<td>300</td>
<td>300</td>
<td>600</td>
<td>1.000</td>
<td>1.100</td>
<td>1.200</td>
<td>0.101</td>
<td>0.025</td>
</tr>
<tr>
<td>0.35811</td>
<td>500</td>
<td>500</td>
<td>1000</td>
<td>1.000</td>
<td>1.100</td>
<td>1.200</td>
<td>0.101</td>
<td>0.025</td>
</tr>
<tr>
<td>0.47146</td>
<td>700</td>
<td>700</td>
<td>1400</td>
<td>1.000</td>
<td>1.100</td>
<td>1.200</td>
<td>0.101</td>
<td>0.025</td>
</tr>
<tr>
<td>0.57180</td>
<td>900</td>
<td>900</td>
<td>1800</td>
<td>1.000</td>
<td>1.100</td>
<td>1.200</td>
<td>0.101</td>
<td>0.025</td>
</tr>
<tr>
<td>0.27374</td>
<td>100</td>
<td>100</td>
<td>200</td>
<td>1.000</td>
<td>1.200</td>
<td>1.200</td>
<td>0.193</td>
<td>0.025</td>
</tr>
<tr>
<td>0.65562</td>
<td>300</td>
<td>300</td>
<td>600</td>
<td>1.000</td>
<td>1.200</td>
<td>1.200</td>
<td>0.193</td>
<td>0.025</td>
</tr>
<tr>
<td>0.86253</td>
<td>500</td>
<td>500</td>
<td>1000</td>
<td>1.000</td>
<td>1.200</td>
<td>1.200</td>
<td>0.193</td>
<td>0.025</td>
</tr>
<tr>
<td>0.95061</td>
<td>700</td>
<td>700</td>
<td>1400</td>
<td>1.000</td>
<td>1.200</td>
<td>1.200</td>
<td>0.193</td>
<td>0.025</td>
</tr>
<tr>
<td>0.98359</td>
<td>900</td>
<td>900</td>
<td>1800</td>
<td>1.000</td>
<td>1.200</td>
<td>1.200</td>
<td>0.193</td>
<td>0.025</td>
</tr>
</tbody>
</table>

References


Report Definitions
Power is the probability of rejecting a false null hypothesis.
N1 and N2 are the number of items sampled from each population.
N is the total sample size, N1 + N2.
R0 is the ratio of the means (μ1/μ2) under the null hypothesis, H0. R1 is the ratio of the means (μ1/μ2) at which the power is calculated.
COV is the coefficient of variation on the original scale. The value of σ is calculated from this.
The effect size is equal to |Log(R0) - Log(R1)|/σ.
Alpha is the probability of rejecting a true null hypothesis.

Summary Statements
A one-sided, two-sample t-test with group sample sizes of 100 and 100 achieves 11% power to detect a ratio of 1.100 when the ratio under the null hypothesis is 1.000. The coefficient of variation on the original scale is 1.200. The significance level (alpha) is 0.025.

This report shows the power for the indicated scenarios.

Plots Section

These plots show the relationship of power to sample size for the two values of R1.
Example 2 – Validation

We will validate this procedure by showing that it gives the identical results to the regular test on differences—a procedure that has been validated. We will use the same settings as those given in Example 1. Since the output for this example is shown above, only the output from the procedure that uses differences is shown below.

To run the power analysis of a \textit{t-test} on differences, we need the values of $\delta$ and $\sigma$.

\[
\delta = \ln(R1) = \ln(1.1) = 0.095310
\]

\[
\delta = \ln(R1) = \ln(1.2) = 0.182322
\]

\[
\sigma = \sqrt{\ln(COV^2 + 1)} = \ln(1.2^2 + 1) = 0.944456
\]

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the \textbf{Two-Sample T-Tests Assuming Equal Variance} procedure window. You may then make the appropriate entries as listed below, or open \textit{Example 2b} by going to the \textit{File} menu and choosing \textit{Open Example Template}.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>One-Sided</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.025</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>Sample Size Per Group</td>
<td>100 to 900 by 200</td>
</tr>
<tr>
<td>Input Type</td>
<td>Difference</td>
</tr>
<tr>
<td>$\delta$</td>
<td>0.095310 0.182322</td>
</tr>
<tr>
<td>$\sigma$</td>
<td>0.944456</td>
</tr>
</tbody>
</table>

Reports Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Means, Difference Decimals</td>
<td>6</td>
</tr>
<tr>
<td>Standard Deviation Decimals</td>
<td>4</td>
</tr>
</tbody>
</table>

Plot Text Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Means, Difference Decimals</td>
<td>6</td>
</tr>
<tr>
<td>Standard Deviation Decimals</td>
<td>4</td>
</tr>
</tbody>
</table>
Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power</th>
<th>N1</th>
<th>N2</th>
<th>N</th>
<th>δ</th>
<th>σ</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.10568</td>
<td>100</td>
<td>100</td>
<td>200</td>
<td>0.095310</td>
<td>0.9445</td>
<td>0.025</td>
</tr>
<tr>
<td>0.23392</td>
<td>300</td>
<td>300</td>
<td>600</td>
<td>0.095310</td>
<td>0.9445</td>
<td>0.025</td>
</tr>
<tr>
<td>0.35811</td>
<td>500</td>
<td>500</td>
<td>1000</td>
<td>0.095310</td>
<td>0.9445</td>
<td>0.025</td>
</tr>
<tr>
<td>0.47145</td>
<td>700</td>
<td>700</td>
<td>1400</td>
<td>0.095310</td>
<td>0.9445</td>
<td>0.025</td>
</tr>
<tr>
<td>0.57180</td>
<td>900</td>
<td>900</td>
<td>1800</td>
<td>0.095310</td>
<td>0.9445</td>
<td>0.025</td>
</tr>
<tr>
<td>0.27374</td>
<td>100</td>
<td>100</td>
<td>200</td>
<td>0.182322</td>
<td>0.9445</td>
<td>0.025</td>
</tr>
<tr>
<td>0.65562</td>
<td>300</td>
<td>300</td>
<td>600</td>
<td>0.182322</td>
<td>0.9445</td>
<td>0.025</td>
</tr>
<tr>
<td>0.86253</td>
<td>500</td>
<td>500</td>
<td>1000</td>
<td>0.182322</td>
<td>0.9445</td>
<td>0.025</td>
</tr>
<tr>
<td>0.95061</td>
<td>700</td>
<td>700</td>
<td>1400</td>
<td>0.182322</td>
<td>0.9445</td>
<td>0.025</td>
</tr>
<tr>
<td>0.98359</td>
<td>900</td>
<td>900</td>
<td>1800</td>
<td>0.182322</td>
<td>0.9445</td>
<td>0.025</td>
</tr>
</tbody>
</table>

You can compare these power values with those shown above in Example 1 to validate the procedure. You will find that the power values are identical.